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การตดิตัง้ Software 

1. ใหท้ าการติดตัง้ตวั “AccessDatabaseEngine” ก่อน  

1.1. โดยดบัเบิลคลิก๊ที่ไฟล ์“AccessDatabaseEngine” (หรอื Download ที่น่ี) 

 

 

 

 

 

1.2. กด Yes 

 

 

 

1.3. กด Next 

 

 

 

 

 

 

 

 

 

 

1.4. คลิก๊เลือก “I accept the terms in the License Agreement” จากนัน้กด Next 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.microsoft.com/en-us/download/details.aspx?id=13255
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1.5. กด Install เพื่อติดตัง้โปรแกรม และรอจนโปรแกรมติดตัง้เสรจ็ 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.6. จะแสดงหนา้ตา่งนี ้เม่ือเสรจ็สิน้การติดตัง้ กด OK เพื่อปิดหนา้ต่าง 

 

 

 

 

 

 

 

 

2. ท าการติดตัง้ โปรแกรม “Calibration Plan” 

2.1. โดยดบัเบิลคลิก๊ที่ไฟล ์“Calibration Plan Setup” 

 

 

 

 

 

2.2. คลิก๊ Yes 
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2.3. กด Next 

 

 

 

 

 

 

 

 

 

 

 

2.4. ระบช่ืุอและบรษิัท (ใสห่รอืไม่ใส่ก็ได)้ จากนัน้กด Next 

 

 

 

 

 

 

 

 

 

 

2.5. กด Next 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 
Page :   4 / 44 

Calibration Plan User Guide V1Rev3 

ติดต่อผูพ้ฒันา E-Mail : Jiranuwat.mai@gmail.com 

2.6. กด Next 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.7. กด Next จากนัน้รอจนโปรแกรมติดตัง้จนเสรจ็ 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.8. เม่ือพบหนา้ตา่งนีก้ด Finish เป็นอนัเสรจ็สิน้ขัน้ตอนการติดตัง้โปรแกรม 
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3. การอพัเดตโปรแกรม 

3.1. ท าการคดัลอกไฟลอ์พัเดตที่ไดร้บัมา 

3.2. ไปวางทบัไฟลเ์ดิมที่ไดท้  าการติดตัง้ไว ้ซึง่โดยปรกติจะอยู่ที่ “C:\Program Files\CalSoft” ส าหรบั

ระบบปฏิบตัิการ 64 บิต หรอื “C:\Program Files (x86)\CalSoft” ส  าหรบัระบบปฏิบตัิการ 32 บิต 

 
 

3.3. เม่ือเปิดโปรแกรมใหม่อีกครัง้ สงัเกตวา่ Version ตรงมมุซา้ยล่างของหนา้ Login ไดเ้ปลี่ยนไปแลว้ 
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การลงทะเบยีน Software 

4. การลงทะเบียนโปรแกรม (ส าหรบั Version ที่ยงัใชก้ารลงทะเบียนแบบใชร้หสั) 

4.1. เม่ือเปิดโปรแกรมครัง้แรก หรอืยงัไม่เคยลงทะเบียนโปรแกรม ตวัโปรแกรมจะถามถึงรหสัปลดล๊อคเพื่อเขา้ใชง้าน

โปรแกรม 

 

 

 

 

 

 

 

 

 

 

 

4.2. ใหท้ าการใสร่หสัปลดล๊อคลงไป  จากนัน้กด Register 

4.2.1. หากยงัไม่มีรหสั ใหค้ดัลอกรหสัแถวแรกส่งใหผู้พ้ฒันา เพื่อช าระเงินและขอรหสัปลดล๊อคต่อไป 

4.2.2. หรอืหากตอ้งการทดลองใชใ้หก้ด Demo version เพื่อเขา้สูห่นา้ทดลองใช ้ 

 

 

 

 

 

 

 

 

 

 

 

4.3. เม่ือรหสัถกูตอ้ง จะแสดงหนา้ตา่งดงันี ้กด OK เพื่อเขา้ใชง้านโปรแกรม 
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การใช้งานโปรแกรม 

5. การใชง้านโปรแกรม 

5.1. การเลือกต าแหน่งฐานขอ้มลู  

ในการเปิดโปรแกรมครัง้แรก โปรแกรมจะใหท้ าการเลือกต าแหน่งของฐานขอ้มลู ซึง่ฐานขอ้มลูจะอยู่ใน Directory 

ที่ติดตัง้โปรแกรมไว ้เช่น โดยทั่วไปจะอยู่ที่ “C:\Program Files\Calibration Plan \Database” ซึง่ภายใน 

Folder “Database” จะมี Access file ช่ือ DataMain.mdb และ Folder “Picture” และ “Certificate” 

**หา้มท าการเปลีย่นชือ่ไฟลท์กุไฟล ์ภายใน Folder “Database” จะท าใหโ้ปรแกรมท างานผดิพลาดได ้

**ควรยา้ย Folder “Database” ไปเก็บใน Drive อืน่ เพือ่ใหส้ามารถแชร์ใหก้บัเครือ่งอืน่ กรณตีดิตัง้โปรแกรม

หลายเครือ่ง และปอ้งกนัความผดิพลาดจากการ Uninstall programและความผดิพลาดจาก VirtualStore ที่

ระบบ Windows จะท าการสรา้งขึน้ หากมไีฟลท์ีต่อ้งแกไ้ขใน Drive C: 

5.1.1. โปรแกรมแจง้เตือนใหเ้ลือกฐานขอ้มลู 

 

 

 

 

 

 

5.1.2. กด “Browse” แลว้ไปยงั Folder “Database” เพื่อเลือกไฟล ์“DataMain.mdb” 
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5.1.3. เม่ือเลือกฐานขอ้มลูแลว้ใหก้ดปุ่ ม “Save” เพื่อบนัทกึขอ้มลู 

 

 

 

 

 

 

 

 

 

 

5.1.4. โปรแกรมจะปิดตวัลง ใหท้ าการเปิดโปรแกรมใหม่อีกครัง้ 
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5.1.5. เม่ือเลือกฐานขอ้มลูไดถ้กูตอ้งแลว้ โปรแกรมก็จะแสดงหนา้ตา่ง Login  

 

 

 

 

 

 

 

5.2. การ Login เขา้โปรแกรม 

โปรแกรมจะมี User พืน้ฐานที่ติดมากบัโปรแกรม นั่นคือ Admin เม่ือ Login เขา้ไปแลว้ก็สามารถเพิ่ม user หรือ

แกไ้ขรายละเอียดต่าง ๆ ได ้

5.2.1. ใสข่อ้มลู  

Name : admin 

Password : admin 

*สามารถเขา้ไปเปลี่ยนรหสัผ่านทีหลงัได ้

5.2.2. กด “Enter” ก็จะสามารถเขา้โปรแกรมได ้

5.2.3. สามารถเปลี่ยน username และ password ไดท้ี่ Setting ของโปรแกรม 

 

 

 

 

 

5.3. การเพิ่มขอ้มลู 

5.3.1. กดเขา้ไปที่เมน ู“Edit>Add new MS profile” 
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5.3.2. ก็จะมีหนา้ตา่งใหก้รอกรายละเอียดของเครื่องมือวดัลงไป โดยช่องที่จ  าเป็นตอ้งใส่ขอ้มลูจะมีเครื่องหมายดอก

จนัสีแดงไว ้หากไม่กรอกขอ้มลูในช่องดงักล่าวโปรแกรมจะไม่ยอมใหบ้นัทกึขอ้มลู 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.3.2.1. สามารถกดปุ่ ม “Check” เพื่อตรวจสอบวา่ Control no นี ้มีการใชง้านแลว้หรือไม่ได ้ 

 

 

 

 

 

 

 

 

5.3.3. ท าการกรอกรายละเอียดต่าง ๆ ลงไป จากนัน้กดปุ่ ม “Save” เพื่อท าการบนัทกึขอ้มลู 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 
Page :   11 / 44 

Calibration Plan User Guide V1Rev3 

ติดต่อผูพ้ฒันา E-Mail : Jiranuwat.mai@gmail.com 

5.3.4. ขอ้มลูที่บนัทกึแลว้ก็จะมาแสดงในหนา้รายการรวม 

 

 

 

 

 

 

 

 

 

 

5.4. การแกไ้ขรายละเอียดเครื่องมือวดั 

5.4.1. ในหนา้รายการเครื่องมือวดัทัง้หมด ใหท้ าการดบัเบิลคลิก๊ รายการเครื่องมือที่ตอ้งการแกไ้ขรายละเอียด 

 

 

 

 

 

 

 

 

 

 

5.4.2. ท าการแกไ้ขรายละเอียดที่ตอ้งการ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

รายละเอียดที่แกไ้ข 
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5.4.3. กดปุ่ ม “Save” เพื่อท าการบนัทึกผล 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.5. การเพิ่มเครื่องมือใหม่ที่มีรายละเอียดเหมือนกนั (การคดัลอกรายละเอียดเครื่องมือวดั) 

5.5.1. ใหด้บัเบิลคลิก๊เขา้รายการที่ตอ้งการคดัลอกรายละเอียดเครื่องมือ 

 

 

 

 

 

 

 

 

5.5.2. จากนัน้ใหก้ดปุ่ ม “Copy”  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

รายการที่แกไ้ขแลว้ 
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5.5.3. Control no. จะหายไป ใหใ้สร่ายละเอียด Control no. อนัใหม่เขา้ไป 

 

 

 

 

 

 

 

 

 

 

 

5.5.4. แกไ้ขรายละเอียดอื่น ๆ ที่ไม่เหมือนกนั 

 

 

 

 

 

 

 

 

 

 

 

5.5.5. กดปุ่ ม “Save” เพื่อท าการบนัทึกผล  ในหนา้รายการเครื่องมือวดัก็จะมีรายการเครื่องมือใหม่ที่ไดค้ดัลอก

รายละเอียดมา 
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5.6. การเพิ่มประวตัิการสอบเทียบ (ก่อนท าการเพิ่มประวตัิการสอบเทียบควรจะเพิ่ม รายละเอียด Lab สอบเทียบก่อน) 

5.6.1. ใหท้ าการดบัเบิลคลิกรายการเครื่องมือที่ตอ้งการเพิ่มประวตัิการสอบเทียบขึน้มา 

 

 

 

 

 

 

 

 

 

5.6.2. จากนัน้ไปที่แทบ “Calibration history” 

 

 

 

 

5.6.3. จากนัน้ใหก้รอกรายละเอียดของการสอบเทียบลงไป 

 

 

 

 

 

 

5.6.4. กดปุ่ ม “Browse” เพื่อคน้หาใบรายงานผลการสอบเทียบ (ตอ้งท าการ Scan เป็น pdf file ไวแ้ลว้) 
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5.6.5. เม่ือกรอกรายละเอียดครบแลว้ใหก้ดปุ่ ม “Add” เพื่อเป็นการเพิ่มประวตัิการสอบเทียบ 

 

 

 

 

 

 

5.6.6. รายการสอบเทียบที่เพิ่มเขา้ไปก็จะไปแสดงในประวตัิการสอบเทียบ 

 

 

 

 

 

 

 

 

5.7. การแกไ้ขประวตัิการสอบเทียบ 

5.7.1. ใหท้ าการดบัเบิลคลิกรายการเครื่องมือที่ตอ้งการแกไ้ขประวตัิการสอบเทียบขึน้มา แทบ “Calibration 

history” 

 

 

 

 

 

 

 

 

 

5.7.2. จากนัน้ใหท้  าการดบัเบิลคลิก๊ประวตัิการสอบเทียบที่ตอ้งการแกไ้ข 
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5.7.3. รายละเอียดตา่ง ๆ ก็จะแสดงขึน้มา 

 

 

 

 

 

 

 

5.7.4. ท าการแกไ้ขรายละเอียด 

5.7.5. เม่ือแกไ้ขเรยีบรอ้ยแลว้ ใหก้ดปุ่ ม “Add” เพื่อบนัทกึผล 

 

 

 

 

 

 

 

5.7.6. รายละเอียดประวตัิการสอบเทียบก็จะถกูแกไ้ข 

 

 

 

 

 

 

 

 

5.8. การเพิ่มหมายเหต ุ(ประวตัิการซอ่ม, การเปลี่ยนอะไหล่, การโยกยา้ยแผนกที่ถือครองเครื่องมือ หรอือื่น ๆ) 

5.8.1. ใหท้ าการดบัเบิลคลิกรายการเครื่องมือที่ตอ้งการเพิ่มประวตัิอื่น ๆ  ขึน้มา 

 

 

 

 

 

 

 

 

 

 

 

 

 

กดปุ่ ม “Add” เพื่อบนัทกึผล 
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5.8.2. จากนัน้ไปที่แทบ “Remark history” 

 

 

 

5.8.3. ใหท้ าการเลือกวนัที่ และใสห่มายเหตทุี่ตอ้งการลงไป 

 

 

 

 

 

5.8.4. ท าการกดปุ่ ม “Add” เพื่อบนัทึกผล 

 

 

 

 

 

รายการที่เพิ่มเขา้มาก็จะแสดงผลดา้นลา่ง 

 

 

 

5.9. การลบรายการเครื่องมือวดั 

5.9.1. เขา้ไปที่เมน ู“Edit>Delete MS profile” 

 

 

 

 

 

 

5.9.2. ใหท้ าการใสห่มายเลขควบคมุเขา้ไป แลว้กดรูปแวน่ขยาย 
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5.9.3. โปรแกรมจะแสดงรายการเครื่องมือที่มีรหสัตรงตามที่คน้หาขึน้มา 

 

 

 

 

 

 

5.9.4. ใหท้ าการเลือกรายการเครื่องมือที่ตอ้งการลบ จากนัน้กดปุ่ ม “ลบขอ้มลู” 

 

 

 

 

 

 

 

 

 

5.9.5. โปรแกรมจะใหยื้นยนัการลบขอ้มลูอีกครัง้ กด “Yes” เพื่อยืนยนัการลบขอ้มลู หรือกด “No” เพื่อยกเลิก 

 

 

 

 

 

 

 

 

 

5.9.6. เม่ือกดลบแลว้ รายละเอียดเก่ียวกบัเครื่องมือวดันีท้ัง้หมดจะถกูลบออกจากฐานขอ้มลู 

 

5.10. การเพิ่มรายละเอียด Calibration Lab 

5.10.1. ใหเ้ขา้ไปที่เมน ู“Setting>Menu setting” 
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5.10.2. จากนัน้ไปที่แท็บ “Supplier” 

 

 

 

 

 

 

 

 

 

 

 

5.10.3. พิมพร์ายละเอียดของ Calibration Lab เขา้ไป จากนัน้กดปุ่ ม “Add” เพื่อบนัทึกผล 

 

 

 

 

 

 

 

 

 
 

 

5.10.4. รายละเอียดที่เพิ่มเขา้ไปก็จะแสดงผลในรายการดา้นลา่ง 
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5.11. การแกไ้ขรายละเอียด Calibration Lab 

5.11.1. ใหเ้ขา้ไปที่เมน ู“Setting>Menu setting” แลว้ไปที่แทบ “Supplier” 

 

 

 

 

5.11.2. จากนัน้ใหด้บัเบิลคลิก๊ รายการ Calibration Lab ที่ตอ้งการแกไ้ข รายละเอียดต่าง ๆ จะขึน้ไปแสดงผล 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.11.3. ท าการแกไ้ขรายละเอียดที่ตอ้งการ จากนัน้กดปุ่ ม “Add” เพื่อท าการบนัทกึผล 
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5.11.4. โปรแกรมก็จะบนัทกึผลตามที่ไดแ้กไ้ขไป 

 

 

 

 

 

5.12. การลบ Calibration Lab 

5.12.1. ใหเ้ขา้ไปที่เมน ู“Setting>Menu setting” แลว้ไปที่แทบ “Supplier” 

 

 

 

 

 

 

5.12.2. ใหท้ าการคลิก๊เลือก Calibration Lab ที่ตอ้งการลบ จากนัน้กดปุ่ ม “Delete” 

 

 

 

 

 

 

 

 

 

 

 

 

5.12.3. โปรแกรมจะถามยืนยนัการลบขอ้มลู กด “Yes” เพื่อยืนยนัการลบขอ้มลู หรอืกด “No” เพื่อยกเลิกการลบ

ขอ้มลู 
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5.12.4. รายการที่เลือกก็จะถกูลบออกจากฐานขอ้มลู 

 

 

 

 

 

 

 

5.13. การเพิ่มหน่วยงานย่อย 

5.13.1. ใหเ้ขา้ไปที่เมน ู“Setting>Menu setting” 

 

 

 

 

5.13.2. จากนัน้ไปที่แทบ “Option” 
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5.13.3. เพิ่มรายละเอียดตา่ง ๆ ลงไปใน Detail และ Description จากนัน้กดปุ่ ม “Add” 

** Detail คอืส่วนทีจ่ะแสดงใหเ้หน็ในสว่นอืน่ของโปรแกรม สว่น Description คอืค าอธิบายของ

กระบวนการนัน้ ๆ จะไม่แสดงผลในสว่นอืน่ของโปรแกรม 
 

 

 

 

 

 

 

 

 

 

 

 

 

5.13.4. รายการที่เพิ่มก็จะบนัทกึเขา้ไปในฐานขอ้มลู 

 

 

 

 

 

 

 

 

 

 

 

 

 

**จะแสดงผลเป็นตวัเลอืกในสว่นทีเ่กีย่วขอ้งกบั Section ดว้ย 

 

5.14. การแกไ้ขหน่วยงานย่อย 

5.14.1. ใหเ้ขา้ไปที่เมน ู“Setting>Menu setting” จากนัน้ไปที่แทบ “Option” 
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5.14.2. ใหด้บัเบิลคลิกรายการที่ตอ้งการแกไ้ขรายละเอียด ขอ้มลูของรายการนัน้ก็จะไปแสดงที่ดา้นบน 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.14.3. แกไ้ขรายละเอียดจากนัน้กดปุ่ ม “Add” เพื่อบนัทกึผล 

 

 

 

 

 

 

 

 

 

5.14.4. รายการดงักล่าวก็จะเปลี่ยนเป็นขอ้มลูที่ไดบ้นัทึกไปใหม่ 

 

 

 

 

 

 

** กรณแีกไ้ข – ขอ้มูลอืน่ ๆ ทีอ่า้งองิไปยงัขอ้มูลก่อนแกไ้ข จะถูกอา้งองิไปหาขอ้มูลทีแ่กไ้ขแลว้อตัโนมตั ิ
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5.15. การลบหน่วยงานย่อย 

5.15.1. ใหเ้ขา้ไปที่เมน ู“Setting>Menu setting” จากนัน้ไปที่แทบ “Option” 

 

 

 

 

 

5.15.2. จากนัน้ใหเ้ลือกรายการที่ตอ้งการลบ แลว้กดปุ่ ม “Delete” 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.15.3. โปรแกรมจะถามยืนยนัการลบขอ้มลู กด “Yes” เพื่อยืนยนัการลบขอ้มลู หรอืกด “No” เพื่อยกเลิกการลบ

ขอ้มลู 

 

 

 

 

 

 

5.15.4. รายการที่เลือกก็จะถกูลบออกจากฐานขอ้มลู 
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5.16. การคน้หาเครื่องมือวดั 

ในหนา้รายการเครื่องมือวดั จะมีเง่ือนไขในการคน้หาขอ้มลูอยู่ 4 ส่วน คือ Control no., Description, Section 

และ Status 

ในสว่นของ Control no. และ Description หากขอ้มลูที่ใชค้น้หามีอยู่ในฐานขอ้มลูเพียงสว่นหนึ่งสว่นใด 

โปรแกรมก็จะดงึขอ้มลูนัน้มาแสดงผลดว้ย  

เช่น คน้หาค าวา่ meter โปรแกรมก็จะแสดงผลของ “Multimeter”, “Micrometer”, “Lightmeter” มา

ทัง้หมด 

5.16.1. กรอกรายละเอียดที่ตอ้งการคน้หาลงไป จากนัน้กดปุ่ ม “Search” 

 

 

 

5.16.2. ขอ้มลูที่ตรงกบัสิ่งที่เราคน้หาก็จะแสดงผลออกมา 

 

 

 

 

 

 

 

 

 

 

5.17. การคน้หาเครื่องมือวดัแบบละเอียด 

5.17.1. ในหนา้รายการเครื่องมือวดั ใหก้ดปุ่ ม “More search” หรอืไปที่เมน ู“Edit>More search” หรอืกดปุ่ ม 

Ctrl+F 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ขอ้มลูที่ในสว่น Description มีค าวา่ “test” ก็จะแสดงผลขึน้มา 
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5.17.2. ก็จะปรากฏหนา้ตา่งการคน้หาเพิ่มเติมขึน้มา 

 

 

 

 

 

 

 

 

 

 

 

5.17.3. ใหท้ าการคลิก๊เลือก Checkbox ที่ตอ้งการจะคน้หา และกรอกรายละเอียดในการคน้หาเขา้ไป 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.17.4. กรณีตอ้งการคน้หาโดยรวมกบัเง่ือนไขการคน้หาในหนา้รายการเครื่องมือวดั ใหค้ลิก๊ถกูที่ “Combine” 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

จากตวัอย่างเงื่อนไขการคน้หาคือ 

Description มีค าวา่ “test” 

Status คือ “Use” 

Model มีค าวา่ “MRX” 
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5.17.5. กดปุ่ ม “Search” โปรแกรมก็จะคน้หารายการเครื่องมือที่ตรงกบัเง่ือนไขออกมา 

 

 

 

 

 

 

5.18. การเพิ่มผูใ้ชง้าน (User ระดบั Admin) 

5.18.1. ใหเ้ขา้ไปที่เมน ู“Setting>Menu setting” 

 

 

 

 

5.18.2. จากนัน้ไปที่แทบ “User” 

 

 

 

 

 

 

 

 

 

 

5.18.3. กรอกขอ้มลู User ใหม่เขา้ไปในส่วน “Add new user” แลว้กดปุ่ ม “Add new” เม่ือขอ้มลูครบแลว้ 
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5.18.4. User พี่เพิ่มเขา้มาก็จะแสดงในรายการทางดา้นขวา 

 

 

 

 

 

 
 

5.19. การแกไ้ขผูใ้ชง้าน (User ระดบั Admin) 

5.19.1. ใหเ้ขา้ไปที่เมน ู“Setting>Menu setting” จากนัน้ไปที่แทบ “User” 

 

 

 

 

 

5.19.2. ดบัเบิลคลิก๊ User ที่ตอ้งการแกไ้ขรายละเอียด รายละเอียดต่าง ๆ ก็จะแสดงผลขึน้มา 

 

 

 

 

 

 

 

5.19.3. แกไ้ขรายละเอียดที่ตอ้งการ กดปุ่ ม “Save edit” เม่ือท าการแกไ้ขเสรจ็แลว้ 

 

 

 

 

 

 

 

 

5.19.4. โปรแกรมก็จะบนัทกึผลที่ไดท้  าการแกไ้ข 
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5.20. การลบผูใ้ชง้าน (User ระดบั Admin) 

5.20.1. ใหเ้ขา้ไปที่เมน ู“Setting>Menu setting” จากนัน้ไปที่แทบ “User” 

 

 

 

 

 

5.20.2. ดบัเบิลคลิก๊ User ที่ตอ้งการลบ 

 

 

 

 

 

 

 

 

5.20.3. คลิก๊ปุ่ ม “Delete” จะมีหนา้ตา่งยืนยนัการลบขอ้มลูขึน้มา กด “Yest” เพื่อลบขอ้มลู หรอืกด “No” เพื่อ

ยกเลิกการลบขอ้มลู 

 

 

 

 

 

 

 

 

 

 

5.20.4. ขอ้มลูก็จะถกูลบออกจากฐานขอ้มลู 
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5.21. การพิมพป์ระวตัิการสอบเทียบออกทางเครื่องพิมพ ์

5.21.1. ท าการดบัเบิลคลิก๊รายการเครื่องมือที่ตอ้งการพิมพป์ระวตัิการสอบเทียบ 

5.21.2. คลิก๊ที่ปุ่ ม “Print” โปรแกรมก็จะแสดงตวัอย่างก่อนพิมพข์ึน้มา 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.21.3. คลิก๊ที่ปุ่ ม “Print” และตัง้คา่การพิมพต์ามเครื่องพิมพท์ี่มี  
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5.22. การดใูบรายงานผลการสอบเทียบลา่สดุ 

5.22.1. ท าการดบัเบิลคลิก๊รายการเครื่องมือที่ตอ้งการดใูบรายงานผลการสอบเทียบขึน้มา 

5.22.2. คลิก๊ที่ปุ่ ม “View last Cert.” โปรแกรมก็จะเปิดใบรายงานผลการสอบเทียบตวัลา่สดุขึน้มา 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.23. การดใูบรายงานผลการสอบเทียบยอ้นหลงั 

5.23.1. ท าการดบัเบิลคลิก๊รายการเครื่องมือที่ตอ้งการดใูบรายงานผลการสอบเทียบยอ้นหลงัขึน้มา 

จากนัน้ไปที่แทบ “Calibration history” 
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5.23.2. ท าการคลิก๊เลือกประวตัิการสอบเทียบที่ตอ้งการดใูบรายงานผลการสอบเที่ยบ 

 

 

 

 

 

 

 

 

5.23.3. จากนัน้กดปุ่ ม “View cert” ใบรายงานผลการสอบเทียบของปีนัน้ก็จะแสดงขึน้มา 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.24. รายละเอียดหนา้ตา่งการแจง้เตือน 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

คลิก๊เลือกรายการที่ตอ้งการดใูบรายงานผลการสอบเทียบ 

สว่นของการแสดงผล – ใหท้ าการเลือกรายการที่

ตอ้งการแสดงผล จากนัน้กดปุ่ ม “Show” โปรแกรมก็

จะแสดงรายการที่เลือกขึน้มา 

สว่นการแจง้เตือน – จะแสดง

รายการใกลค้รบก าหนด, เลย

ก าหนด และรายการที่รอการ

อนมุตัิขึน้มา 

ปุ่ มเขา้โปรแกรม 
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5.25. การส่งขอ้มลูออกทาง Excel 

5.25.1. ที่หนา้รายการเครื่องมือ เขา้เมน ู“File>Export to Excel” 

 

 

 

 

 

 

 

 

 

 

5.25.2. ขอ้มลูดงักล่าวก็จะถกูส่งออกไปยงั Excel file  

 

 

 

 

 

 

 

 

 

 

 

 

 

5.26. การสรา้งแผนการสอบเทียบ 

ควรท าการสรา้งแผนการสอบเทียบ เม่ือมีขอ้มลู (Due date) ในปีนัน้ ๆ ครบถว้นมากที่สดุ  

5.26.1. เขา้ไปที่เมน ู“Calibration plan>View plan” 

 

 

 

 

 

 

 

 

 

 

 

 

ขอ้มลูที่จะถกูส่งออกไปยงั Excel file 
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5.26.2. ท าการกรอกปีที่ตอ้งการสรา้งแผนการสอบเทียบขึน้มา จากนัน้กดปุ่ ม “New Plan” 

 

 

 

 

 

 

 

 

 

 

 

5.26.3. กรณีที่มีแผนสอบเทียบปีนัน้อยู่แลว้ โปรแกรมจะถามยืนยนัการสรา้งแผนสอบเทียบ กด “Yes” เพื่อท าการ

สรา้งแผนใหม่ หรอืกด “No” เพื่อยกเลิกการสรา้งแผนสอบเทียบ 

 

 

 

 

 

 

 

5.26.4. เม่ือสรา้งแผนใหม่เรียบรอ้ย ใหก้ดปุ่ ม refresh เพื่ออพัเดตการแสดงผลกราฟของปีนัน้ ๆ  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

**ขอ้ควรระวงั – การสรา้งแผนการสอบเทยีบทบัปีเดมิทีม่ขีอ้มูลอยู่แลว้ จะท าใหข้อ้มูลจ านวนการสอบเทยีบ

เดมิถูกลบไปดว้ย 

**ถา้มีการเพิ่มประวตักิารสอบเทยีบ Calibration plan จะท าการ update ใหอ้ตัโนมตัิ 
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5.27. การแกไ้ขแผนการสอบเทียบ 

5.27.1. เขา้ไปที่เมน ู“Calibration plan>View plan” 

 

 

 

5.27.2. ใหท้ าการดบัเบิลคลิก๊เดือนที่ตอ้งการแกไ้ขรายละเอียดแผนการสอบเทียบ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.27.3. ก็จะมีหนา้ตา่งแสดงรายละเอียดของเดือนนัน้ ๆ ขึน้มา สามารถคลิก๊ขวา เพื่อแกไ้ขจดัการ โดยจะมีเมนใูห้

แกไ้ขดงันี ้

 

 

 

 

 

 

 

 

5.27.3.1. Add new – เพิ่มรายการเครื่องมือเพิ่มเติมในเดือนนี ้โดยกรอกหมายเลขควบคมุแลว้กดปุ่ ม 

“เพิ่ม” 

 

 

 

 

 

 

ขอ้มลูรายละเอียดที่แสดง จะเป็นของกราฟที่แสดงผลอยู่  

จากตวัอย่างคือของปี 2017 

เมนเูม่ือคลิก๊ขวา 
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5.27.3.2. Move schedule to other month – ยา้ยแผนการสอบเทียบของการการที่เลือกไปเดือนอื่น 

 

 

 

5.27.3.3. Delete schedule – ท าการลบรายการที่เลือกออกจากแผนในเดือนนี ้

 

 

 

 

 

 

 

 

 

5.27.4. เม่ือแกไ้ขรายการเรียบรอ้ยแลว้ ใหก้ดปุ่ ม refresh เพื่อแสดงผลในกราฟ 

 

 

 

 

 

 

 

 

 

 

 

 

5.28. การลบแผนการสอบเทียบ 

5.28.1. ใหท้ าการเลือกปีแผนสอบเทียบที่ตอ้งการลบ จากนัน้ใหค้ลิก๊ขวา ก็จะมีเมนใูหเ้ลือก 

 

 

 

 

 

 

 

**จะไม่สามารถลบปีทีก่ าลงัแสดงผลอยู่ได ้

ตวัอย่างการยา้ยแผนสอบเทียบ จากเดือน July ไปยงัเดือน October 
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5.28.2. จะมีขอ้ความยืนยนัการลบขอ้มลู กด “Yes” เพื่อยืนยนัการลบขอ้มลู หรอืกด “No” เพื่อยกเลิกการลบ

ขอ้มลู 

 

 

 

 

 

5.28.3. แผนการสอบเทียบ ก็จะถกูลบออกจากฐานขอ้มลู 

 

 

 

 

 

 

 

 

 

5.29. การดแูละเลือกแผนสอบเทียบที่ตอ้งการแสดงผล 

5.29.1. ใหท้ าการเลือกปีแผนสอบเทียบที่ตอ้งการแสดงผลกราฟ จากนัน้ใหค้ลิก๊ขวา ก็จะมีเมนใูหเ้ลือก 

 

 

 

 

 

 

 

 

 

5.29.2. เลือก “Set show data” จากนัน้กดปุ่ ม refresh       กราฟก็จะแสดงผลของปีที่เลือก 
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5.30. การบีบอดัไฟลฐ์านขอ้มลู 

5.30.1. ไปทีเมน ู“Setting>Compact database” 

 

 

 

 

 

 

 

5.30.2. โปรแกรมก็จะท าการบีบอดัฐานขอ้มลู  

 

 

 

 

 

 

 

5.31. การตัง้คา่ E-Mail service 

5.31.1. ในหนา้ตา่ง “Setting” ใหค้ลิกเลือกแท๊บ “E-Mail" จะปรากฏหนา้ตา่งการตัง้ค่า E-Mailขึน้มา โดยการ

ตัง้คา่จะแบง่เป็น 4 สว่น คือ การตัง้คา่ Mail service, CC E-Mail, E-Mail body detail และ Test send 

e-mail 
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5.31.1.1. การตัง้คา่ E-Mail service  

คา่ตา่ง ๆ ในส่วนนีส้ามารถสอบถามไดก้บัทาง E-Mail service provider ที่ท่านใชอ้ยู่ หรือปรกึษา

กบั IT บรษิัท มาตัง้คา่ให ้

 

 

 

 

 

 

 

 

5.31.1.2. CC E-Mail 
ใหร้ะบ ุE-Mail ที่ตอ้งการใหส้่งดว้ย เม่ือมีการแจง้เตือนอตัโนมตัิจากโปรแกรม สามารถระบ ุE-Mail 

เพิ่มเติมไดโ้ดยเพิ่ม “,” คั่นระหวา่ง E-Mail 

 

 

 

5.31.1.3. E-Mail body detail 

เนือ้หาใน E-Mail ที่ตอ้งการจะส่ง เม่ือมีการแจง้เตือนอตัโนมตัิจากโปรแกรม ซึ่งจะตามดว้ยรายการ

เครื่องมือที่ใกลค้รบก าหนดในรอบนัน้ ๆ  

 

 

 

 

5.31.1.4. Test send E-Mail 
ทดสอบการสง่ E-Mail เพื่อทดสอบวา่การตัง้ค่า E-Mail service ถกูตอ้ง และส่ง E-Mail ออกได้

หรอืไม่ โดยสามารถเลือกประเภทการส่งได ้3 ประเภท คือ Plain text (ขอ้ความธรรมดา), With 

attached file (ส่งแบบมีไฟลแ์นบเป็น pdf file) และ with html (รายการเครื่องมือจะรวมอยู่ใน 

เนือ้หา E-mail เลย) 

 

 

 

 

 

 

 

 

 

 

 
ประเภท E-Mail ที่สามารถทดสอบสง่ได ้
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**รูปแบบพืน้ฐานในการสง่รายการแจง้เตือนคือ แบบ With html หากลกูคา้ตอ้งการสง่แบบมีไฟล์

แนบสามารถแจง้กลบัทางผูพ้ฒันาได ้

 

5.32. การตัง้คา่ E-Mail ส าหรบัแต่ละส่วนงาน 

5.32.1. ใหไ้ปที่ “Setting” แลว้เลือกแท๊บ “Option” จากนัน้ใหเ้ลือก Type เป็น Section 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.32.2. ให ้ดบัเบิลคลิก สว่นงานที่ตอ้งการเพิ่ม E-Mail จากนัน้ คลิก “Ref. Mail” จะปรากฏหนา้ตา่งเพิ่ม E-

Mail ขึน้มา 
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5.32.3. ในการเพิ่มใหพ้ิมพ ์E-Mail ที่ตอ้งการเพิ่ม ส ารบัสว่นงานนีเ้ขา้ไป จากนัน้คลิกเครื่องหมายบวก 

 

 

 

 

 

5.32.4. E-Mail ส าหรบัหน่วยงานนีจ้ะแสดงขึน้มาที่รายการดา้นลา่ง 

 

 

 

 

 

 

 

 

5.32.5. สามารถเพิ่ม E-Mail อื่น ๆ ส าหรบัหน่วยงานนีไ้ด ้โดยท าซ า้วิธีการเดิม 

5.32.6. หากตอ้งการลบ ใหด้บัเบิลคลิกที่รายการที่ตอ้งการลบ จะมีหนา้ตา่งแจง้เตือนขึน้มา 

 

 

 

 

5.32.7. เม่ือคลิกยืนยนั รายการดงักล่าวก็จะหายไป 

 

5.33. การตัง้คา่ Line และ ก าหนดการแจง้เตือน “Line and Trigger” 

เม่ือไปที่เมน ู“Setting” แลว้เลือกแท๊บ “Line and Trigger” จะมีการตัง้คา่ต่าง ๆ แบง่เป็นส่วน ดงันี ้
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5.33.1. Next alarm date – คือจ านวนวนั ที่ตอ้งการใหต้รวจหาเครื่องมือและแจง้เตือนลว่งหนา้ 

 

 

5.33.2. Line setting – ส่วนของการตัง้คา่การแจง้เตือนผ่าน Line 

 

 

 

• Line Token – คือคีย ์ส  าหรบัติดต่อกบั Line service เพื่อแจง้เตือนไปยงักลุ่มที่ไดท้  าการตัง้ค่าไว ้การ

ออก Line Token สามารถศกึษาไดจ้าก https://lazedev.blogspot.com/p/line-token-

line.html 

• Enable Line Notify – เปิด/ปิด การแจง้เตือนผ่าน Line 

• Test notify – ทดสอบการแจง้เตือนผ่าน Line โดยจ าเป็นตอ้งกรอก Line Token ก่อน จึงจะสามารถ

ทดสอบการสง่ได ้

5.33.3. Schedule trigger – ส่วนการตัง้คา่การแจง้เตือน 

5.33.3.1. ก าหนดการแจง้เตือน - จะมีการแจง้เตือนอยู่ 2 แบบ คือ แจง้ตามวนัที่ ที่ไดก้  าหนดไว ้และ แจง้

ทกุก่ีวนั 

 

 

 

 

 

 

 

 

• การแจง้เตือนตามวนัที่ (No. 1 – 3) 

 

 

 

 

 

โปรแกรมจะท าการแจง้เตือนเม่ือถึงก าหนดตามวนัที่และเวลา ที่ไดต้ัง้คา่ไว ้และเม่ือแจง้เตือน

แลว้ โปรแกรมจะก าหนดการแจง้เตือนในวนัที่นีข้องเดือนถดัไป ตอ่เน่ืองไปเรื่อย ๆ  

หากในวนัที่ดงักล่าว ไม่มีการเปิดโปรแกรม โปรแกรมจะท าการแจง้เตือนเม่ือมีการเปิดโปรแกรม

ครัง้ถดัไป 

 

 

https://lazedev.blogspot.com/p/line-token-line.html
https://lazedev.blogspot.com/p/line-token-line.html
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• การแจง้เตือนตามจ านวนวนัที่ก  าหนด (No. 4) 

 

 

 

โปรแกรมจะท าการแจง้เตือนเม่ือถึงก าหนดตามวนัที่และเวลาที่ไดต้ัง้คา่ไว ้และเม่ือแจง้เตือนแลว้ 

โปรแกรมจะท าการเพิ่มจ านวนวนั ตามที่ไดต้ัง้คา่ไว ้เพื่อก าหนดวนัแจง้เตือนครัง้ถดัไป 

เช่น เม่ือตัง้คา่แจง้เตือน ทกุ 6 วนั เม่ือมีการแจง้เตือนวนัที่ 5 มกราคม การแจง้เตือนครัง้ตอ่ไปคือ

วนัที่ 11 มกราคม 

5.33.3.2. ตัง้คา่ใหท้  าการส่งการแจง้เตือนจากเครื่องนี ้

 

 

กรณีมีการซือ้ Software ติดตัง้หลายเครื่อง จ าเป็นตอ้งก าหนดว่าใหเ้ครื่องไหน เป็นเครื่องที่ใชส้่ง การ

แจง้เตือน ไว ้เพื่อปอ้งกนัการท างานทบัซอ้นกนั 

5.33.3.3. ดกู าหนดการ การแจง้เตือนครัง้ตอ่ไป 

 

 

 

 

 

 

 

สามารถดกู าหนดการ การแจง้เตือนไดโ้ดยคลิกที่ “View” โปรแกรมก็จะแสดงก าหนดการ การแจง้

เตือนครัง้ถดัไปขึน้มา 

5.34. การจดัการขอ้มลู “Log information” 

โปรแกรมมีการจดัเก็บประวตัิการแกไ้ข หรือแจง้เตือนตา่ง  ๆ ไว ้เช่น สถานะการส่ง E-Mail แจง้เตือน, 

สถานะการ Login, สถานะการแกไ้ขประวตัิ เป็นตน้ เราสามารถจดัการ Log ตา่ง ๆ ไดด้งันี ้

 

 

 

 

 

 

 

 

 

 



 

 
Page :   45 / 44 

Calibration Plan User Guide V1Rev3 

ติดต่อผูพ้ฒันา E-Mail : Jiranuwat.mai@gmail.com 

5.34.1. การลบ Log – ใหท้ าการดบัเบิลคลิกรายการใน Log จากนัน้โปรแกรมจะมีขอ้ความยืนยนัการลบขอ้มลู  

เม่ือกดยืนยนัโปรแกรมก็จะท าการลา้งขอ้มลู Log ทัง้หมดออกไป 

 

 

 

 

 

 

5.34.2. การอพัเดต – ท าไดโ้ดยการคลิกขวาใน Log จากนัน้รายการ Log ก็จะอพัเดต และแสดงรายการที่ไดเ้พิ่ม

ขึน้มา 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

**กรณีโปรแกรมท างานผิดพลาด หรือมีขอ้สงสยั ติดตอ่ผูพ้ฒันาไดท้ี่ E-Mail : Jiranuwat.mai@gmail.com 

- END - 


